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Installing and Exploring
Web Matrix

So, you want to be a web developer eh? You want to write great looking Internet applications,
but don't want to learn lots of arcane programming stuff? I can't say I blame you – most
programming these days is far more complex than it needs to be. However, this doesn't have to
be the case, so don't think it's beyond you – we're going to show you something that'll get you
creating great applications in no time at all.

When Microsoft released ASP.NET in early 2002, Web development got much easier. The
trouble was that it was still too hard for many people. Why? The breadth of what ASP.NET was
able to do left some people floundering. Many developers who were used to an older way of
creating dynamic web applications were overwhelmed by the scale of ASP.NET. But the
problem wasn't with the new features; it was more a case of understanding how to make these
new features work, both conceptually, and in practice. The development tool that Microsoft
supply is designed for large-scale web application development, and such it is quite complex.
It's also expensive – and both of these factors put many people off.

The solution to this particular problem is an easy-to-use tool, at the right price. That's where the
Microsoft ASP.NET Web Matrix Project comes in. In this book we're going to teach you how to
create great web applications using the easiest, and cheapest of tools. In this chapter we're
going to look at:

❑ How and why Web Matrix came to life

❑ How to install the Microsoft .NET Framework, and associated products

❑ How to install the Microsoft Web Matrix development tool

❑ How to use the features available in Web Matrix

As we go through the book you'll see how easy web development can be when using the right tool.
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What is the Microsoft Web Matrix?
Microsoft Web Matrix is a web development tool designed for creating ASP.NET web pages. A
simple description, but it doesn't really tell you much, such as what it does, why you should
use it, and why it's available in the first place. You might not think those are important
questions, but the answers give you some ideas as to why you'd want to use Web Matrix.

When .NET was released, the main development tool promoted was Visual Studio .NET (VS .NET).
As Web developers, we've been used to a plethora of tools, but more often than not, when coding
old-style ASP pages, we've used Notepad. It's small and quick, but doesn't have any features
specifically designed for web development. VS .NET brought a really rich design-time environment,
including database support, drag-and-drop design, and so on. However, VS .NET is an advanced
development tool, with many features not required by many people creating ASP.NET applications.

The Web Matrix Project on the other hand, was designed with ASP.NET in mind. It's very small
(it fits on a floppy disk), has great design features, and best of all, it's free!

Web Matrix Features
Before we dive into the installation, let's take a quick look at the features of Web Matrix, to see
why it's so compelling:

❑ It's small. This means it's quick to download, copy, or distribute to friends. It also
means it doesn't take much memory or disk space.

❑ It has got great design features, such as a drag-and-drop page designer, templates for
existing web pages, pre-supplied code, and so on. This makes it extremely easy to use.

❑ It doesn't require any other files. VS .NET uses a project-based system that creates
extra files to manage a project. Web Matrix just uses a single file for each web page,
and doesn't rely on any built-in features. This means that you can edit the pages in any
other code editor if you need to.

❑ Community support. There's built-in support for links to the ASP.NET community,
including the news groups and mailing lists.

Oh, and did I mention it's free? You can (and are encouraged to) freely distribute Web Matrix.
Let's now run through the installation so you get to play with Web Matrix as quickly as possible.

Installation
Installation of Web Matrix is simple, and takes place in several steps. Inserting the Web Matrix
CD (included in the back of this book) will bring up a web page outlining the installation steps.
If the web page doesn't appear, then just run the startcd.exe program from the CD
directly – this will launch the start page.
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Installing Microsoft .NET
Before you can install Web Matrix you need to install the .NET Framework. If you've already got
this installed then you can skip this step. The version on the Web Matrix CD is .NET Framework
1.0. From the main start page from the CD you'll see a set of steps, labeled 1 to 4. If you follow
these in order you end up doing more work than is necessary, so skip straight to Step 4.

The .NET Framework SDK, installed in Step 4, includes the .NET Framework, the MSDE
database setup utility, the ASP.NET quickstart code samples, and the .NET Framework
documentation. The only thing it doesn't include is Web Matrix, which we'll install
 from Step 2.

1. Pick the right hand link, to install the Microsoft .NET Framework Software
Development Kit (SDK). This installs .NET version 1.0, plus all of the documentation:

2. Click Open to start the installation. You may receive this warning:
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This just tells you that you haven't got a web server installed on the machine. Don't worry
about this, as Web Matrix comes with its own web server, so you don't have to install a web
server separately.

If you have IIS installed on your system, you can use either the IIS web server, or the web
matrix web server once you've installed Web Matrix – the Web Matrix installation
doesn't overwrite anything, and the two co-exist nicely.

So if you do see this message, just press Continue and you should see the following:

3. Press Next to start the installation wizard:
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4. Select I accept the agreement, and press Next to continue:

5. Make sure that both optional checkboxes are ticked, and press Next:

6. Leave the settings at their defaults, and press Next. This starts the SDK installation,
and it's time to go and make a cup of coffee – watching the install screen is rather dull.

Once this stage of the installation is finished, you can, and should, take time to install the
service packs (which are updates designed to fix small bugs and potential security holes in the
Framework). You can either install just the first service pack from the CD (as linked in Step 1),
or you can go to the Microsoft Windows Update site (http://www.windowsupdate.com) and
download the most recent service packs.
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Installing the Database Server Software
Once the SDK installation has finished, you need to install the database server software – this
will allow you to run the sample applications, as well as create your own databases.

1. Select the Microsoft .NET Framework SDK program group, and then select Samples
and QuickStart Tutorials.

2. From the resulting page, select Step 1: Install the .NET Framework Samples Database:

3. You'll then be prompted with the following – select Open. This will install the
database software.

4. After rebooting your system, if you have IIS installed on your system, you can
continue to Step 2 of the quickstart installation, and install the samples and tutorials.
Included in this installation are four sample databases, one of which we'll be using
later on, so we recommend that you then run Step 2 in the installation.
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Installing the Sample Databases Manually
If you don't have IIS installed on your system, you can install it (on compatible operating
systems) by following the instructions in Appendix A, then follow Step 2. For those of you who
don't have the option of installing IIS (if you're running Windows XP Home Edition, or if you
simply don't want to install IIS), you need to run some different code to install the database
we'll use later in the book. You need to run a small installation script, available with the
Chapter01 code download for this book (the details of how to download the code for this
book are in the Introduction).

To install the databases using the installation script file in the code download for this chapter,
open the Chapter01 folder, within the BegWebMatrix downloaded folder. Run the
InstallDatabases.bat file, and the installation script will run and install the databases.
When it's finished running, you will see the following screen:

This script is also very useful if ever you need to restore the sample
databases, for example, if you've inserted or deleted data from the sample
databases and want to return them to their initial state. Whenever you want
to do this, simply re-run this script, and the Northwind, Pubs, Grocer To Go,
and Portal databases will be restored.

After this installation, you will have a database configured to run with the instance name
of (local)\NetSDK, and you will have access to four sample databases on that server.
You'll find out more about what this actually means in Chapter 8.
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Installing Web Matrix
At this stage you now have both .NET and database software installed. All that's left is Web
Matrix. Now you can switch back to the screen from the CD (if it's closed just run
startcd.exe from the root directory of the CD), and scroll to Section 2:

1. To install Web Matrix click the first link, to give the following:

2. Click Open to start the installation:
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3. Click Next to continue:

4. Enter your User Name and Organization (you can leave this blank if you like). By
default the Web Matrix will be available for all users who use the computer, but you
can make it available only to yourself. I'd recommend leaving the default here. Press
Next to get to the features screen:
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5. Since Web Matrix is very small and has all of its features included, there's not much to
choose here. Just leave the settings as they are and press Next to perform the installation.

6. Once complete you can check to see if the installation was successful by running Web
Matrix – there will be a new menu under the Programs menu from the Start button – it
will be labeled Microsoft ASP.NET Web Matrix:

Upon starting Web Matrix you'll see the following screen:
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We'll look at these options a little later, but now you know it works, let's carry on looking at the
installation options.

Tours and Tutorials
As part of the set up routine from the Web Matrix CD there are three extra features. The first is
a video, with some interviews with users of Web Matrix, telling you how great it is.

The Web Matrix Guided Tour

The second is the guided tour – a set of HTML pages explaining how some of the features can
be used.
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ASP.NET Quickstart Tutorial

The third is the tutorial for ASP.NET itself.

You don't need to explore any of these in detail yet, so let's carry on with the installation.
However, once you've started using ASP.NET it's worth spending some time browsing through
the ASP.NET QuickStart Tutorial. It's full of great examples of ASP.NET.

Visit the Web Site
The home of ASP.NET is shown in the last step of the installation screen:

This site is maintained by the Microsoft team that develops ASP.NET, and should be on your
Favorites list. Not only is it where new announcements are made, where articles are posted,
and where controls are available, but it also provides a set of forums. These are invaluable for
getting help with ASP.NET problems, and it's well worth joining.
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A Tour of Web Matrix
Now you've done all of the installation tasks, it's time to start looking into Web Matrix, to see
exactly what features it has, and how to use them. This will be a quick tour around the interface
so you know what each section is, and how it's used. The specifics of each area will be
investigated in later chapters, as each becomes relevant.

New Item Dialog
Let's start with the New Item dialog. This is what you see when you want to create a new
ASP.NET file, and is the first thing you see when you run Web Matrix:

At the top we have two sections for templates – one for the type of template, and one for the
template itself. Underneath that we have two text entry areas, where you can specify the
location of the file, and its name. You should make sure you leave the file suffix (.aspx in this
case) at the end of the file name, since Web Matrix doesn't automatically add one.

In the Code section at the bottom of the screen, there is a selection list to pick the language you
want to use when writing code. We're going to be using Visual Basic .NET in this book (the
other language you could use is C#). Finally there is a checkbox to allow you to specify
advanced features for the new file. This is useful if you need to change the default class name
and namespace for the file – we'll be keeping the defaults so you should leave this unchecked
unless told to change it.
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Templates
Templates in Web Matrix act just like templates in other tools, such as Microsoft Word or Front
Page. They provide a default for the style and content of the page. In some cases with Web
Matrix the templates provide almost all you need to create great web pages. There are six
template types, or groups:

❑ (General). General templates for all types of ASP.NET pages. These don't have much
in the way of content or code.

❑ Data Pages. Data pages, containing grids and lists. These have lots of code already in
place, and provide a quick way to have pages that show tables of data from a database.

❑ Mobile Pages. For creating pages to be used on mobile devices, such as phones. The
Mobile Internet Toolkit needs to be installed for this, which is Step 3 on the Web Matrix
install page. We won't be looking at mobile devices in this book, but for more information
have a look on the Wrox website – there are several books that cover this in detail.

❑ Output Caching. Pages that are cached in memory, and are therefore faster.

❑ Security. Login and logout pages, for creating secure websites.

❑ Web Services. Pages that can be called remotely by other applications. Web services
are Internet applications that just provide functionality, and have no interface,
allowing companies to use your code. For example, Amazon has a web service that
allows you to programmatically access its database, search for files, access your wish
list, and so on.

You'll see many of these in use as we go through the book, but feel free to have a play with
them yourself.

To learn about the rest of the interface, let's show you the main areas of Web Matrix. To do that
we need to create a new Web page, so select the (General) tab, and from the templates pick
ASP.NET Page. You'll now need to specify the name and location for the file. You can leave the
name of the file set to NewFile.aspx if you like, but change the directory for your file to
C:\BegWebMatrix – you may need to create this directory if it doesn't already exist.
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We recommend using a separate directory so that the web pages you create as you work through
this book are kept separate from your other documents. In general, it's a good idea to create a
separate directory for each set of files you are working on – this stops you getting them mixed up
with each other. Once you've typed in the Location and Filename, press the OK button.
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The Main Window
You are now in the main window of Web Matrix, which has several areas:

Editing
Toolbar

Formatting
Toolbar

Design and Code Editor

C
on

tr
ol

 T
oo

lb
ox

Properties Pane
File and D

ata W
orkspace

The file that you've just created is shown in the center – this is the Design and Code Editor. To
the left, we have the Control Toolbox, which is where the web controls sit. Web controls are the
way we provide content on our page – they can create buttons, areas for inputting text, and so
on. We'll be covering them in more detail in Chapter 3.

To the right we have the File and Data Workspace, showing the files and directories and
databases you are working with. Below that is the Properties pane, showing the properties for a
selected item on the Design editor. At the top we have the Editing and Formatting toolbars,
allowing you to change files, and modify the formatting and style of controls on your form.

Let's now have a look at these areas in turn.

Design, HTML, and Code Pane
This area is the main work area, and shows you different views of your web page. By default
you're shown the Design view, which gives you a visual view of your page. The HTML tab
switches you to a view that shows the HTML equivalent of the design, and the Code view
shows only the code associated with the page. The All tab shows all views together.
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Let's have a go at using these tabs, so you get familiar with how they work.

Try It Out Putting Controls on a Form

1. If you haven't already got a file open (if you have, skip to Step 3), create a new
ASP.NET file. To do this select New from the File menu, hit Ctrl-N, or use the New File

toolbar button – that's the one that looks like this: 

2. From the New File dialog, make sure the path is set to C:\BegWebMatrix (or any
other path you wish to use), enter a name for the file, and press OK.

3. With the new file open, and the Design tab selected, pick a control from the Toolbox on
the left. Start with a Label control, and drag it onto the Design surface and drop it there.

4. Do the same with a TextBox, and drop it next to the Label.

5. On the Design surface, place the cursor on the page to the right of the TextBox and
press the Return key.

6. Now drag a DataGrid from the Toolbox and drop it under the Label and TextBox. Your
page should now look like this:
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7. Click the HTML, Code, and All tabs, and note how what's shown in the window changes.
You're still dealing with the same file, it's just that the tabs give you a different view of
that file. We'll be using these other tabs more as we go through the book.

Properties and Formatting
At the bottom right of Web Matrix there's the Properties tab, which allows you to set the details
on controls. Let's have a quick look at what you can do with these.

Try It Out Changing the Look

1. Switch the main window back to Design view, and click on the Label.

2. In the Properties pane, you'll notice that there are two columns. The first column
shows the name of the property, and the second shows the value. Scroll down to find
the Text property, and change the text from Label to Enter your name:
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3. From the formatting toolbar, click the bold button – this will turn the text for the
label bold.

4. Now pick a different font and size from the drop-down list on the toolbar – I seem to
have one called Poor Richard (who Richard is and why we should feel sorry for him is
a mystery to me!). We look at fonts in more detail in Chapter 3.

5. Click on the TextBox and move to the Properties window.

6. Pick a color for the BorderColor property, change the BorderStyle to Dashed, and enter
5 for the BorderWidth.

7. Click on the DataGrid, and move to the Properties window.

8. At the bottom of the properties window you see two links in blue:

9. Click the Auto Format… link, to bring up the formatter. This is just like formatting
tables in Word:
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10.Pick a style of your choice, and click OK.

11.Your page should now look something like this:

OK, it doesn't look particularly great, but you can see how the properties affect the controls.
You can press F5 to run this program in your browser. The first time you do this you'll see a
message called Start Web Application – make sure that Use ASP.NET Web Matrix Server is
selected and press Start. In the next chapter we'll create a more useful page and run it, so you'll
get more practice of controls and properties. Let's now continue with our tour of the Web
Matrix interface.

Toolbars and Menus
The toolbars and menus are, for the most part, fairly obvious. However, a brief explanation
never goes amiss, so let's start with the menu:
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❑ File: Standard type of file menu, allowing addition of new files, saving files, printing,
and so on.

❑ Edit: Cut, copy, paste, find, replace and so on.

❑ View: Allows switching between the different views (Design, HTML, Code, All), as
well as some design view features (which are also shown on the design toolbar).

❑ Format: Mirrors some functionality of the formatting toolbar, allowing font changes,
alignment, and so on.

❑ Layout: Allows alignment and sizing of controls.

❑ HTML: Allows insertion of standard HTML features, such as a hyperlink or a table.
The issue of which controls to use is covered in Chapter 3.

❑ Workspace: Allows addition of new items, and connections to remote websites.

❑ Tools: Web Matrix tools, such as customization of the toolbox.

❑ Window: Cascade, Tile, and so on.

❑ Help. Links to the help file and URLs.

The two toolbars are equally sensible. The first is the editing toolbar:

New, Open,
Save, Print

Cut, Copy,
Paste, Undo,
Redo

Search Run

Toggle
Design Borders

Toggle
Design Grid

Help

Toggle
Toolbox

Toggle
Glyphs

Toggle
Snap to Grid

The second is the formatting toolbar:

Heading Style

Font name
and size

Foreground and
Background
colors

Bold,
Italic,
Underine

Lists Tag editing

Absolute
position

Indentation
Text
alignment
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Toolbox
You've already used the Toolbox, but it does warrant a little explanation. It works in much the
same way as the Outlook Bar works in Microsoft Outlook, where there are different pop-up tab
sections, and only one section is visible at once. There are five sections:

❑ HTML Elements, which contains the standard HTML controls

❑ Web Controls, which contains the ASP.NET Web Controls

❑ Custom Controls, for custom controls written by third parties

❑ Code Builders, for wizards that write code for you

❑ My Snippets, for snippets of code you want to keep and reuse

The Code Builders section is only viewable when you are viewing code via the Code tab or the
All tab. You'll see examples of all of these in later chapters of the book. They all work in the
same way though – you drag from the Toolbox onto your page. When in design view, the
control appears on the design surface. When in code view, dragging a Code Builder starts a
wizard that writes code, which is then inserted into the code at the position you dragged to (so,
make sure you drag these onto an empty line). It's worth having a play with these, just so you
are familiar with what they do. Don't worry about messing up your file, since you don't have to
save it when you quit Web Matrix.

Workspace and Data
The Workspaces area at the top right of Web Matrix deals with files and data. Here there are
three tabs:

❑ Workspace, showing a view on your current disk (or FTP site if that's what you're using)

❑ Data, showing connections to databases, and the tables within the databases

❑ Open Items, showing a list of files currently open

Using the Workspace is covered in the next two chapters, and the Data tab is covered Chapter 8.

Classes and Community
The two windows we haven't yet looked at are the Classes and Community tabs, which sit
alongside the Properties window. The first of these shows all of the underlying classes that
make up the .NET Framework. Some of these you may use as you get more experienced, some
you may never use, and some just aren't relevant to ASP.NET. However, it's useful for
exploring, and to understand what classes are available for use. Classes and code are covered in
Chapters 4 to 6.
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The Community window gives you links to the best places on the web for ASP.NET resources.
Among these are the forums from http://www.asp.net/, where you can find a great many people
available to help with any ASP.NET-related trouble you might be having, and also, some of the
ASP.NET development team from Microsoft hang out there.
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Summary
This chapter has been all about beginnings. It's the start of a journey that will turn you into a
web developer. Like many things in life, experience counts, so we need to gain that experience,
and the only way to do that is actually do things. Yoda put it succinctly in a Star Wars film –
"Try not. Do." So in this chapter we've "done". We've taken the first step towards our goal of
learning how to create great web applications.

We started with installing the tools we needed – the Microsoft .NET Framework, a database, the
Web Matrix development tool, and a whole bunch of documentation. This is exactly the same
procedure that experienced web developers run through, so you're already on that journey –
doing the things that need doing.

We then examined the Web Matrix itself, having a look at its features, and how you use them.
We created a web page, dragged some controls on, and set some properties. Pretty easy stuff,
but then most of what you'll be doing in the book starts with that easy stuff; how hard can it
be? So, let's get on with it, and start creating some real web pages, that have real content, and
allow the user to enter data and interact with them.
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